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Photoshop Elements 

is a digital image 

editing program that 

comprehensively spans the 

gap between very basic 

programs and professional-

level ones. This chapter 

introduces the various 

workspaces and modes of 

Elements and shows how to 

access them and details what 

can be done with each one.
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About Elements
Photoshop Elements is the offspring of the professional-level 
image-editing program, Photoshop. Photoshop is somewhat 
unusual in the world of computer software, in that it is widely 
accepted as being the best program of its type on the market. 
If professional designers or photographers are using an image-
editing program, it will almost certainly be Photoshop. However, 
two of the potential drawbacks to Photoshop are its cost and its 
complexity. This is where Elements comes into its own. Adobe 
(the maker of Photoshop and Elements) has recognized that the 
majority of digital imaging users (i.e. the consumer market) want 
something with the basic power of Photoshop, but with enough 
user-friendly features to make it easy to use. With the explosion 
in the digital camera market, a product was needed to meet the 
needs of a new generation of image editors – and that product is 
Elements.

Elements contains most of the same powerful editing/color 
management tools as the full version of Photoshop and it also 
includes a number of versatile features for sharing images and 
for creating artistic projects, such as slideshows, cards, calendars 
and online photo albums. It also has valuable features, such as the 
Guided edit and Quick edit modes, where you can quickly apply 
editing techniques and follow step-by-step processes to achieve a 
range of creative and artistic effects.

Special effects
One of the great things about 
using Elements with digital 
images is that it provides 
numerous fun and creative 
options for turning mediocre 
images into eye-catching works 
of art. This is achieved through a 
wide variety of guided activities 
within Guided edit mode, 
which have been added to and 
enhanced in Elements 13.

Advanced features
In addition to user-friendly features, Elements also has an Expert 
editing mode where you can use a range of advanced features, 
including a full set of tools for editing and color adjustments.

The New icon pictured 
above indicates a new 
or enhanced feature 
introduced with 
the latest version of 
Photoshop Elements 13.

Photoshop Elements 
can be bought online 
from Adobe and 
computer and software 
sites, or at computer 
software stores. There 
are Windows and Mac 
versions of the program 
and with Elements 13  
these are virtually 
identical. If Elements 
13 is bought from the 
Adobe website, at 
www.adobe.com, it 
can be downloaded and 
installed directly from 
there. Otherwise it will 
be provided on a DVD, 
with a serial number 
that needs to be entered 
during installation.
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l2 Click on the Organizer button to go to that area

Welcome Screen
When you first open Elements, you will be presented with the 
Welcome Screen. This offers initial advice about working with 
Elements and also provides options for accessing the different 
workspaces. The Welcome Screen appears by default but this can 
be altered once you become more familiar with Elements.

Welcome Screen functions

l1 Options for organizing photos, editing them and using 
them in a variety of creative ways

l3 Click on the Photo Editor button to go to that area

The Welcome Screen can 
be accessed at any time 
by selecting 
Help > Welcome 
Screen from the Photo 
Editor or Organizer 
Menu bar. Click on this 
button at the top of 
the Welcome Screen to 
select options for what 
happens when Elements 
is launched.
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Photo Editor Workspace
From the Welcome Screen the Photo Editor workspace can be 
accessed. This is a combination of the work area (where images 
are opened and edited), menus, toolbars, toolboxes and panels. At 
first it can seem a little daunting, but Elements has been designed 
with three different editing modes to give you as many options as 
possible for editing your photos.

The components of the Photo Editor (Editor) are:

Menu bar Editor mode buttons  Panels bin

Toolbox Taskbar  Work area 

Editor modes
The three different modes in the Photo Editor are accessed from 
the buttons at the top of the Elements window. They are:

• Quick edit mode. This can be used to 
perform quick editing options in one step

• Guided edit mode. This can be used to 
perform a range of editing techniques in a 
step-by-step process for each

• Expert edit mode. This can be used for the 
ultimate control over the editing process

In Elements 13 there is 
an eLive button on the 
top toolbar too. This 
links to a range of help 
and news articles about 
Elements. See pages  
24-25 for details.



11

One of the options on the Taskbar is the Tool Options. This 
displays the available options for any tool selected from the 
Toolbox (different tools are available in each of the different 
Editor modes). To use this:

l1 Select a tool and click on the 
Tool Options button to 
show or hide the Tool Options 
panel (by default it is visible 
when a tool is first selected). 
Other tools within specific sets can also be selected within 
the Tool Options panel

Photo Bin
The Photo Bin is another feature that can be accessed from all 
three Editor modes. The Photo Bin enables you to quickly access 
all of the images that you have open within the Editor. To use the 
Photo Bin:

l1 Open two or more images. 
The most recently-opened 
one will be the one that is 
active in the Editor window

l2 All open images are shown 
here in the Photo Bin

l3 Double-click on an image in the Photo Bin to make that 
the active one for editing

Taskbar and Tool Options
The Taskbar is the group of buttons that is available across all 
three Editor modes at the bottom left of the Elements window:

...cont’d

The items on the Taskbar 
are, from left to right, 
show or hide the Photo 
Bin, show or hide the 
Tool Options panel, undo 
the previous actions, 
redo any undone 
actions, rotate the active 
photo and access the 
Organizer. In Expert 
mode there is also an 
option to change the 
Layout.

Images can also be made 
active for editing by 
dragging them directly 
from the Photo Bin and 
dropping them within 
the Editor window.

When an image has 
started to be edited, this 
icon appears on its top 
right-hand corner in 
the Photo Bin.
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Quick edit mode contains a number of functions that can be 
selected from panels and applied to an image, without the need to 
manually apply all of the commands. To do this:

l1 In the Editor, click on the  
Quick button

l2 The currently-
active image is 
displayed within 
the Quick edit 
window. This 
has the standard 
Taskbar and 
Photo Bin and a 
reduced Toolbox. 
Click here to 
access the Quick edit panels

l3 Select one of the 
commands to have it 
applied to the active 
image. This can be 
applied either by 
clicking on one of the 
thumbnail options 
or by dragging the 
appropriate slider at the 
top of the panel

l4 Click on these 
buttons at the 
bottom of the Quick 
Edit panel to select 
Adjustments, Effects, Textures and Frames 
options for adding to photos

Quick Edit Mode

For a more detailed look 
at Quick edit mode, have 
a look at Chapter Four.

Move the cursor over 
one of the thumbnails to 
view a real-time preview 
of the effect on the 
open image. Click on 
one of the thumbnails to 
apply the effect.
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l3 Select one of the actions that 
you want to perform. This 
will take you to a step-by-step 
process for undertaking the 
selected action

Guided edit mode focuses on common tasks for editing digital 
images and shows you how to perform them with a step-by-step 
process. To use Guided edit mode:

l1 In the Editor, click on the  
Guided button

l2 The currently-active image is displayed within the Guided 
edit window. This has the standard Taskbar and Photo 
Bin but only two tools in the Toolbox. The Guided edit 
options are available in the right-hand panel

Guided Edit Mode

Guided edit mode is a 
great place to start if 
you are new to image 
editing, or feel unsure 
about anything to do 
with it.

The tools in the Guided 
edit mode Toolbox 
are the Zoom tool for 
magnifying an image 
and the Hand tool for 
moving around.
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Taskbar Layout button  Expert mode Panel buttons

The Layout button is the one addition on the 
Taskbar within Expert mode, as opposed to 
Quick and Guided edit modes. Click on the 
Layout button to access options for display of 
open photos within the Editor window.

Expert edit mode is where you can take full editing control over 
your photos. It has a range of powerful editing tools so that you 
can produce subtle and impressive effects. To use Expert mode:

l1 In the Editor, click on the  
Expert button

l2 The full range of editing tools is available

Expert mode Toolbox   Open panels

Expert Edit Mode

The Organizer can be 
accessed from any of the 
Editor modes by clicking 
on this button on the 
Taskbar:
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The Expert Toolbox
The Toolbox in Expert mode contains tools for applying a wide 
range of editing techniques. Some of the tools have more than 
one option. To see if a tool has additional options:

l1 Move the cursor over the Toolbox. Tools 
that have additional options appear with a 
small arrow in the top right-hand corner 
of their icons. Click on a tool to view the 
options within the Tool Options panel

The default Toolbox tools are (keyboard shortcut in brackets):

...cont’d

Move (V)

Zoom (Z)

Lasso (L)

Red Eye Removal (Y)

Paint Bucket (K)

Blur (R)
Smart Brush (F)

Brush (B)

Text (T)
Color Picker (I)

Content-Aware (Q)

 Crop (C)

 Foreground Color

Hand (H)

Rectangular Marquee (M)

Custom Shape (U)

Spot Healing Brush ( J)

Quick Selection (A)

Sponge (O)

Clone Stamp (S)

Gradient (G)

Eraser (E)

Recompose (W)

Pencil (N)

Straighten (K)

Background Color

The tools that have 
additional options are: 
Marquee, Lasso, Quick 
Selection, Healing Brush, 
Type, Smart Brush, 
Eraser, Brush, Stamp, 
Shape, Blur and Sponge.

Keyboard shortcuts can 
be used by pressing 
the Shift key and the 
appropriate letter.

If the Toolbox is not 
visible, select 
Window > Tools from 
the Editor Menu bar.
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...cont’d

Panels
In Expert edit mode, Elements uses panels to group together 
similar editing functions and provide quick access to certain 
techniques. The available panels are:

• Actions. This can be used to perform automated actions over 
a group of images at the same time.

• Adjustments. This can be used to add or make editing 
changes to adjustment layers in the Layers panel.

• Color Swatches. This is a panel for selecting colors that can 
then be applied to parts of an image or elements that have 
been added to it.

• Effects. This contains special effects and styles that can be 
applied to an entire image or a selected part of an image. 
There are also filters which have their own dialog boxes in 
which settings can be applied and adjusted. Layer Styles can 
also be applied to elements within an image.

• Favorites. This is where favorite graphical elements from the 
Content panel can be stored and retrieved quickly.

• Graphics. This contains graphical elements that can be added 
to images, including backgrounds, frame shapes and text.

• Histogram. This displays a graph of the tonal range of 
the colors in an image. It is useful for assessing the overall 
exposure of an image and it changes as an image is edited.

• History. This can be used to undo any editing steps that have 
been performed. Every action is displayed and can be reversed 
by dragging the slider next to the most recent item.

• Info. This displays information about an image, or a selected 
element within it. This includes details about the color in an 
image or the position of a certain item.

• Layers. This enables several layers to be included within an 
image. This can be useful if you want to add elements to an 
existing image, such as shapes or text.

• Navigator. This can be used to move around an image and 
magnify certain areas of it.

The panels are located 
in the Panel Bin, which 
is at the right of the 
Editor window. In Expert 
edit mode this can be 
collapsed or expanded 
by selecting Window 
> Panel Bin from the 
Menu bar.
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Working with panels
The default Expert edit mode panels (Layers, Effects, Graphics 
and Favorites) are located at the right-hand side of the Taskbar. 
Additional panels can also be accessed from here. To work with 
panels in Expert edit mode:

l1 Click on one of the panel 
buttons on the Taskbar to 
open the related panel

l2 If there are additional tabs for a 
panel click on the tab to view the 
other options

...cont’d

l3 Click on the More button to view the rest 
of the available panels

l4 The additional panels are 
grouped together. Click 
on a tab to access the 
required panel. Click and 
drag on a tab to move the 
panel away from the rest 
of the group

Click here to access the 
menu for an open panel.

Do not have too many 
panels open at one time. 
If you do, the screen will 
become cluttered and it 
will be difficult to edit 
images effectively.
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Menu Bar
In the Editor, the Menu bar contains menus that provide all of 
the functionality for the workings of Elements. Some of these 
functions can also be achieved through the use of the other 
components of Elements, such as the Toolbox, the Tool Options 
panel and the panels. However, the Menu bar is where all of the 
commands needed for the digital editing process can be accessed 
in one place.

Menu bar menus 

• File. This has standard commands for opening, saving and 
printing images.

• Edit. This contains commands for undoing previous 
operations, and standard copy-and-paste techniques.

• Image. This contains commands for altering the size, shape 
and position of an image. It also contains more advanced 
functions, such as changing the color mode of an image.

• Enhance. This contains commands for editing the color 
elements of an image. It also contains quick-fix options and 
commands for creating Photomerge effects such as panoramas 
and combining exposures.

• Layer. This contains commands for working with different 
layers within an image.

• Select. This contains commands for working with areas that 
have been selected within an image, with one of the selection 
tools in the Toolbox.

• Filter. This contains numerous filters that can be used to 
apply special effects to an image.

• View. This contains commands for changing the size at which 
an image is displayed, and also options for showing or hiding 
rulers and grid lines.

• Window. This contains commands for changing the way 
multiple images are displayed, and also options for displaying 
the components of Elements.

• Help. This contains the various Help options.

Although the Menu bar 
menus are all available 
in each of the Editor 
modes, some of the 
menu options are not 
available in Quick edit or 
Guided edit mode.

The Mac version of 
Elements also has a 
Photoshop Elements 
menu on the Menu 
bar. This contains the 
Preferences options.

Elements does not 
support the CMYK color 
model for editing digital 
images. This could be 
an issue if you use a 
commercial printer.
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Preferences
A number of preferences can be set within Elements to determine 
the way the program operates. It is perfectly acceptable to leave 
all of the default settings as they are, but as you become more 
familiar with the program you may want to change some of the 
preference settings. Preferences can be accessed by selecting 
Edit > Preferences from the Menu bar (Adobe 
Photoshop Elements Editor > Preferences in the Mac 
version). The available ones are:

• General. This contains a variety of options for selecting items, 
such as shortcut keys.

• Saving Files. This determines the way Elements saves files.

• Performance. This determines how Elements allocates 
memory when processing editing tasks. It also determines 
how Elements allocates disk space when processing editing 
tasks (scratch disks). If you require more memory for editing 
images you can do this by allocating up to four scratch disks 
on your hard drive. These act as extra areas from which 
memory can be used during the editing process.

• Display & Cursors. This determines how cursors operate 
when certain tools are selected.

• Transparency. This determines the color, or transparency, of 
the background on which an open image resides.

• Units & Rulers. This determines the unit of measurement 
used by items, such as rulers.

• Guides & Grids. This determines the color and format of 
any guides and grids that are used.

• Plug-Ins. This displays any plug-ins that have been 
downloaded to enhance image editing with Elements.

• Type. This determines the way text appears when it is added 
to images.

• Organize & Share. These preferences open in Organizer 
mode and offer a collection of options for each function. 
These are General, Files, Editing, Camera or Card Reader, 
Scanner, Keyword Tags and Albums, Sharing, Adobe Sharing 
Services, Media-Analysis and Adobe Revel for online sharing.

Each preference has its 
own dialog box in which 
the specific preference 
settings can be made.

A scratch disk is an area 
of temporary storage 
on the hard drive that 
can be utilized if the 
available memory (RAM) 
has been used up.

Guides and grids can be 
accessed from the View 
menu in Editor mode.
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Organizer Workspace
The Organizer workspace contains functions for sorting, viewing 
and finding multiple images. To use the Organizer:

l1 In any of the Editor modes, click on the  
Organizer button on the Taskbar

The Organizer has four views, in addition to eLive, accessed from 
these buttons:

• Media View

• People View

• Places View

• Events View

Media View
The Media View displays thumbnails of your photos, and also has 
functions for sorting and finding images:

Folders and Albums View buttons  Thumbnails

Organizer Taskbar  Instant Fix and Tag/Info buttons

Images displayed in 
the Media View can 
be located anywhere 
on your computer. The 
thumbnails in Media 
View are just references 
to the originals, wherever 
they are stored.
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Events View
This view can be used to group photos 
according to specific events such as 
birthdays and vacations.

Click on these buttons to apply image-editing 
effects to a selected image in Media View, or view 
the Tags and Information panels.

...cont’d

People View
This view can be used to tag specific 
people and then view photos with those 
people in them.

Places View
This view can be used to place photos 
on a map so that they can be searched 
for by location.

For information about 
using the Organizer, and 
its different views, see 
Chapter Two.
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Create Mode
Create mode is where you can release your artistic flair and start 
designing items such as photo books and photo collages. It can 
also be used to create slide shows and to put your images onto 
discs. To use Create mode:

l1 In either the Editor or the Organizer, 
click on the Create button

l2 Select one of the Create projects. 
Each project has a wizard that takes 
you through the create process

l3 The Create wizard takes you through 
the process so you can display your 
photos in a variety of creative ways

For a more detailed look 
at Create mode have a 
look at pages 173-176.
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l3 In previous 
versions of 
Elements, the 
Share function 
was only 
available from 
the Organizer. 
However, in 
Elements 13 
there are also 
some share 
options that can 
be accessed from 
the Editor

Share Mode
Share mode can be used to distribute your images to family and 
friends in a number of creative ways. To use Share mode:

l1 In the Organizer, click on the  
Share button

l2 Select one of the Share 
options, such as sharing 
to social networking sites, 
sharing via email or the 
Adobe Revel photo-sharing 
service which is accessed 
through the Private Web 
Album option

For a more detailed look 
at Share mode see pages 
168-172.
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l2 Click on one 
of the items to 
see more details. 
This links to 
a selection of 
online resources 
including, 
for Inspire, 
the Elements 
Facebook page

Inspire
The Inspire section provides details of how  
you can get more out of your photos:

l1 Click on the 
Inspire button 
from the main 
menu to view 
the options

eLive is a new function in Elements 13 and it provides a selection 
of tutorials and videos for getting the most out of Elements. To 
access these, click on the eLive button on the top 
toolbar in either Editor or Organizer mode.

Menu options
There are three sections with eLive, Inspire, Learn and News:

l1 Click on this button to view the 
menu options

eLive

To use the resources in 
the eLive section you 
need to have an online 
connection to access the 
various types of content.
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l2 Click on one of the 
items to see more 
details. For News, this 
takes you to the Adobe 
website

News
The News section provides details of how you can keep up-to-
date with the latest news about Elements.

l1 Click on the News 
button from the main 
menu to view the 
options

Learn
The Learn section provides details of how you can learn a range 
of photo editing techniques:

l1 Click on the Learn 
button from the main 
menu to view the 
options

...cont’d

l2 Click on one of the 
items to see more details. 
This links to a selection of 
online resources including, 
for Learn, the Elements 
YouTube page

If there are any updates 
to the eLive resources, 
this is indicated by a red 
icon with a number in it, 
on the eLive button.
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Getting Help
One of the differences between Elements and the full version of 
Photoshop is the amount of assistance and guidance offered by 
each program. Since Photoshop is aimed more at the professional 
end of the market, the level of help is confined largely to the 
standard help directory that serves as an online manual. Elements 
also contains this, but in addition it has the Getting Started 
option which is designed to take users through the digital image 
editing process as smoothly as possible. The Getting Started 
option offers general guidance about digital imaging techniques 
and there are also help items that can be accessed by selecting 
Help from the Menu bar. These include online help, information 
on available plug-ins for Elements, tutorials and support details.

Using the help files

l1 Select Photoshop Elements Help from the Help 
menu and click on an item to display it in the main 
window. Use the left-hand panel to view the different 
help categories
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